PC Applications
i. Identify a common PC application used in the work place.

Common PC applications

Applications for PCs or laptop computers are sometlmevs called PC or desktop applications, and those for maobile
devices are called mobile apps.

There are many PC applications out there, and they fall into many different categories. The most common computer
applications that we will use are:

ii. Define word processing

ili. Define spreadsheet

iv. Define database

vi.

vit.

1. Word processing application (Word Processor) o
2. Spreadsheet application G- 2
3, Database application * 4
4 A program or.eassiese for storing, manipulating, and formatting text entﬁred from a keyboard and
providing a printout. P
: ™
~ An electronic document in which data is arranged in the rows and columns of a grid and can be
manipulated and used in calculations.
4 A usually large collection of data organised especially for rapid search and retrieval (as by a computer). o
-
State the purpose of a word processor
State the purpose of a spreadsheet
State the purpose of a database ’,\\ £ p ’::,
Name of known
/ Application Type Main Parpose application '
Wozd Proc A word processor allows you to write a letter, The most well known word ’
N B detign a fiyer, and create many other kinds of processor is Microzoft \
docuxents. Y Fia | 54 7
i A Spreadsheet allows you to quickly calculate The most well known ’ “
Spreadsheet _numerical data, represeat data with charts and can | spreadsheet is Rligrosoft - 'ﬁ. viii
R mbaé‘ Ty. p (/" A gy / el 2
A dambase management system allows you to use 8 Thase ase many dstsbase & /
Database o Databage | COmPuter 10 create a database. It also aliows you 10 milibhht
ey add, sont, modify and select particular data, as well is one of ¢
BMENTS I 2510 create forms 20d repors using the datm in the | AR .
database,
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The common features shared by the applications.

[ Common feature | Description
Editing facilities The ability to change your work using specific editing tools. ; '}:’; 'y
s il

Undo

The ability to undo any editing or formatting changes.

Save and Close a file

Ta keep a copy of your work for future use, you need to save it by giving it
a filename. Once you have saved your work, you can close the file by
clicking the Close command on the File menu or the Close Window button
on the menu bar.

Spelling and grammar
checkers

Identifying spelling and grammatical errors in a document ai

-ﬁ;_“

Cut and paste

Text/graphics can be rearranged within the same document or betwéen a
number of documents

Page formatting

The ability to have different layouts, margins and pagination

Character formatting

Using bold, underline and italics to ch the app: ceofach B

Text alignment

Positioning text or bers 1o specified margin and tab seltings. The four
primary types of text alignment include left aligned, right aligned, centered,
and justified.

Justification Automatic alignment of text to both the left and right margins.
Page numbering The ability to Ily add page bers to a d
quential numbering of pages.
Search and Repleace Moving directly to specified words or parts of words within a document and
replacing them with different words or word portions.
Headers and Footers Option of creating blocks of text or bers that will lly appear
at the top or bottom of each page in a document.
Word wrap Automatic arrangement of text in lines of specified length without the
ity of touching the return key.
F , end! Fe are notes that appear at the bottom (or “foot”) of the page.
Print a file There are two ways to print a file on which you are working:

1. Press the Print button on the Standard toolbar to send your file to the
printer using all the default settings

2. Select Print on the File menu, which will open the Print dialog box so that
you can adjust the printer settings

State a basic features of a spreadsheet
QOutline the basic features of a spreadsheet

Spreadsheet feature

Description

Opening a worksheet

When you open a spreadshect application a worksheet opens. Each sheet
is a full spreadsheet. Having a workbook with multiple sheets allows you
to easily establish relationships from one sheet to another.

€2 455 sneets £tz g 7~

Name of worksheet

The name of the sheet can be changed. Double-click the name of the
sheet in the tab at the bottom, and type the new name.

L4 > M\ Summary [ Project )\ Survey /

| 35 |




Cells

LN

Each rectangle in a spreadsheet is called a cell. For example, the first cell
in a spreadsheet is A1. The "A" stands for the column and the "1" stands
for the row.

Select cells

Click the mouse and drag to highlight multiple cells with this cursor, or
click in a cell to select the single cell

T i
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Moving content of 2
cell

Click and drag the contents of the selected cell to any other cell.

Copy content of a cell

Click and drag with this cursor to fill cell contents into cells below or to
the right.
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Enter formula

Click to place the cursor into the Formula bar so that you can edit an
equation or function.

Entering Data

Move to the cell where you want to enter data and enter words or
numbers. If data is already in the cell it will be replaced without having
1o cut or delete the previous data.
‘Things that can be entered into a cell:

e numbers

e words

e cequations, formulas or functions

« fill color

Charts

Creating of different type of charts to visually represent data

State a basic feature of a
Outline the basic features of a database.

database.

Bt et
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Database Table A database stored data or i s similar in appearance

 StudentID: - | Student. . [ Villag

15 "-?;?i e e P SHE

S LRAE R o S 2
101 Fifita Nau Afa 12
102 ‘Ana Ma’u Kolomotu’ | 13

a
103 Tevita Finau | Nukunuku | 12
S 104 Lose Toafa Havelu a1
L

to a spreadsheet, in that data is stored in rows and columns,
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Record Each table contains a lot of records. Each row of the table is a record
oonhiningdahor'_“ ion that belongs to one person or a thing.
Studeﬁﬁb £ ?tudent s iagtie] ) illage & Ag 13
Fifita Nau A
102 ‘Ana Ma’'u Kolomotu’ | 13
' a
103 Tevita Finau | Nukunuku | 12
. 104 Lose Toafa Havelu 11
Ficlds Each individual piece of data or information in a record is called a field.
’ , e | |Age.
i 5
FifitaNau | Afa )
102 ‘Ana Ma'u Kolomotu” | 13
a
103 Tevita Finau | Nukunuku | 12
104 Lose Toafa Havelu 11
Primary Key Every single record in a database has something to uniquely identify it
and this is called the primary key.
v
101 Fifita Nau Afa 12
AN
102 ‘Ana Ma’u Kolomotu’ | 13
a
103 Tevita Finau Nukunuku | 12
104 Lose Toafa Havelu 11

xxiii. Define Worksheet.

A Worksheet or sheet is a single page in a file created with an electronic spreadsheet program such as Microsoft

Excel.

xxix. Name a common type of chart available in a spreadsheet application

- On the Insert tab, in the Charts group, choose Line, and select Line with Markers.



Me ] Insert l Page Layout Formutas Data ‘Review View Daveloper
This paragraph will shotw you a few things about Word. For example, you don't have to press RETURN at

= ] Elzll (P Shapes * ﬁm }00( & m I ;) ! .
E E @] Q J e . the end of each line; Word starts new lines automatically. You press RETURN only when you want to start

PivotTable Table | picture Ciip Bso | Column| Une | Pie  Bar Area Scatter Other a new paragraph. Notice that you "push” the Insert Pointer and the aph symbol al
v { At GFSceenshot~ ) v P v - v v Charts~ | end this paragraph, press RETURN when you finish typing this séu(enc; e e T
Tables | ltustrations | 2-D Line ) . y
Al v (" f<| Month s -/ [ - Now type this short line.

) B ol . i o ] ) e_“l l ‘EZ' E:_‘ |
_1 [Month Bears ~ Dolphins Whales e ] i
_2 fsan 8 150 80) ‘ ,.;d -’ ‘,- l proge” iu_ﬁtg!inx Text _
"3 [reb 4 77 54 ! v I ‘ 1 ? Your Insert Pointer is now blinking after the period at the end of the short line.

4_|Mar 93 32 100 150 1] Line vt Backees ‘
= ¢ : { v" Use the left arrow ke h

5 |apr 16 . 1 76 ) ; y or the right arrow key of your keyboard (to the right of the s
2 ; : . 2 pacebar) to move th
_6 |May 137 [ Fh R 3:?:)'{::?«2?: 3‘3;3’1‘.‘;"' | Pointer back until it's on the right side of the "s" of "this." ) ¢

7 llun L 184 TR ATeT2

Useful when there are only a few

5] rroohesterb o v 'l".rfs; thet;)elefe key ((,upper right corner of the keyboard) to remove the "s," and press it again to remove the

9 - i." Now type "e," and you have changed "this" to "the." So the line should read li -
-;B_L | short line.” ad |ike this = "Now type the

S - - L3 .
wxxvi. Define Database record. v :;/l?ve thte M:use Pointer anywhere else in your text (using the mouse) and click. That also moves the Insert
i ointer to where you click inside ;
A record in a database is an object that can contain one or more values. Groups of records are then saved ina ppsisaiiocs r:lwve et t:’;f\:’e‘:;‘:‘:“)mw' {Notice that the Mouse Ppinter changes from an | to an
tables, the table defines the data that each record may contain. 2 Gd) h W CUF r/ =
4. Formatting Text. ‘ ; : '
wowvii. Define flat-file database table. (Formatting Tool bar) -
—"‘/— ——

G B P 4
[ | 3 £3 Sirand 2.Using PC Application [Compatibility Mode] - Word (Product Actwation Failed)

There are two main types of computer database:

. plee JIERHTEN - INstRT ) DESIGN - PAGE LAYOUT + REFERENCES™ " MAIUINGS - *REVIEW ~_ ViEW

1. Flat file - all data is simply stored in one table and can be accessed from this single table " ;
2. Relational - data can be shared with or ‘related’ to other multiple tables in the same database. ﬂ - ML | P~ : {98 A B
3 P Y a8bCche A3

Heading

xxxviii. Define Database field.

Database field is a place for e plece of information in a record or file. 4.1 Adding a title.
xliv. State a required step in creating a project using a common application.
425
«lv. Outline the steps involved in creating a project using a comman application. elect a Word or a Group of Words to Delete, Replace, or Change.
xlv. Explain the steps involved in creating a project using a common application. 4.3 Change Font Size.

xIvii, Discuss the steps involved in creating a project using a common application.
4.4 Save, Print and Exit a document
Word Processing - Creating your first Word document
. Starti lication (Microsoft Wo other word processing pro;
v Using the mouse put the arrow pointer on the start menu and then click on all programs. Move the pointer (Practical Activity 1.3 - Page 70 - 72)
to Microsoft Office to highlight it, and then over to the right-hand menu to Microsoft Word and double click
onit.
v The main window for Word appears.

Spreadsheet ~ Creating your first spreadsheet

2. Entering Text
Type the sample paragraph below. Read and follow the directions as you type iton the computer. Don't worry about 1.5 lication (Microsoft Excel)

mistakes. | want you to make mistakes so | can show you how to correct them. H ;
Using the mouse put the arrow pointer on the start menu and then click on all programs. Move the pointer

to Microsoft Office to highlight it, and then over to the right-hand menu to Microsoft Excel and double click
on it. Release the button.

Microsoft Excel Tool bar

3|Page s .
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2. Entering Text and Numbers.
Click inside of cell A1 on your spreadsheet, and do the following:

Type the word "Numbers" (with no quotation marks), Hit the Enter key on your keyboard The active cell will move
down one, to cell A2, Type the number 3, and again hit the Enter key on your keyboard. The active cell will move
down one, to cell A3, Now put the number 6 into cell A3, and the number 8 in cell A4. After you have typed the
number 9, and hit the Enter key, you should see that cell AS is now the active cell.

AS o ———
: e

3. Editin i ell >

To change the text in cell A1, you can just click inside of the cell and start typing. Anything you had there previously
would be erased. But if you just want to edit the text (if you've made a spelling mistake, for example), then you need
to do scmething else. You can use the formula bar for editing.

4. Font formatting

You can pick a different font for the data you enter into cells, as

well as choosing the size you want. The colour of the font, and ]
the cell background, can be changed, too. First, we'll see howto s
change the font type. ' '2:.....‘?"""“
- .
R
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5. Cell Colour
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To change the background colour of cells, you first have to highlight the cells you want to change. We'll start with
the cells A2 to A5. So highlight these cells on your spreadsheet.

6. Saving your work in Excel

Clicking Close, will close the current Excel spreadsheet, but won't close down Excel itself. To close down Excel, click
the "Exit Excel” button in the bottom right of the dialogue box.

Save As
B oo [C:J Computer
Rcend foideny
w1 My Dovuronty
~ Devacp
L
R
L e
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Practical Activity: Page 82-88 & Activity 1.4 Page 89

Database — Creating your first database

Microsoft Access is a popular computer application used to create and manage computer-based databases. Similar
to the previous applications you can start this program, by clicking Start, Programs, Microsoft Office, Microsoft Office
Access 2010 or an earlier version of MS access.

To create a new database, you can choose File then New. Choose a blank database to start a new database
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Table 1 will appear. Click on “Click to Add".  Lockup Wizard...

Return to Datasheet View by clicking View, Datasheet View.
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Enter details for the first two fictional employees. Type Mary, press Enter to move to the next column, and type o """": \“ : AL
o - weld Nang
Smith. Press Enter twice to move to the second column of the second row, and type Peter, press Enter and finally ol] TIPS el ......k,,.,:,n,m ,‘._,,,_:
. histName Test
type Johnson. “ Pt hat Vi ! Lasthamn Test
You need to alter the design at this point, because it does not have any table headers, so that you can use employee ] h: =
ID numbers. To make these changes, click the View drop-down menu on the Home tab of the Manu toolbar, and el
select Design View. i
§

iﬁ Marme Creste

s 1’ 5, 2o Type the numbers 2011 and 2045 in the first column of the table. Once the table is complete, save it by right-clicking
Ea | 3%t the Employees tab and clicking Save.
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Practical Activity 1.5: Page 94
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Design Applications:

i Define graphic design
- The art or skill of combining text and pictures in advertisements, magazines, or books.

ii. Define desktop publishing
- Itisthe creation of documents using page layout skills on a personal computer primarily for print.

iii. Name a graphic design or dasktop publishing application.
a. Graphic Design: Adobe Photoshop, Adobe lllustrator, Adobe Dreamweaver
b. Desktop Publishing: Microsoft Publisher, Adobe InDesign, Microsoft Word

iv. State a key principle of graphic design.

v. Outline the basic principles of graphic design

vi. State a key feature in creating graphics or publications

vii. Outline special features for creating graphics or publications
viii. Identify examples of text-based publication

Graphic designers follow key principles and concepts of graphic designs and their application by using modern

desktop publishing applications. @ i}j
?{f—-—qa\ \’(A @} i S e — \’l £
. (The Building Blocks ofos/ily .7 - )0‘\ T .
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The five (5) basic ele 5 5 pes, mass, texture, and color.

%\l(\

Alineisa mark connecting two pom_t_sJLmes can be solld dashed thlck thm, or of variable width. The

endings of lines can be rag ed, blunt, or curv
~ o Shapgs em————" "\ “‘9‘\0? 'V—CH‘W /S PARL
Squares (and rectangles), trian s an fm’; are the three basic shapes The three bas pes of shape

are geometric, natural, and abstract. G ﬂn_etrlc shapes,are structured, often symmetrical shapes. These
include squares, cnrc|es, and triangles but also octagons, gons, and cones
ﬂ /7 »

» Mass E‘«u&\ - e men
/ Mass is‘one of the basic elements of design. Mass equals size Each plece yo reate has a physlcal mass.

) S———————————
Texturg /_....\
v Texture is the visual or tactile surface characteristics of/ piece of deslgn i! Si(ﬁv
“ e Colour b1 /\ pﬂt"’y

This is the combination of colours that go well together in a design.
- ———s —— e S _f
s § 2 (=
N
Six (6) key principles and concepts of graphic designs
1. Balance - evenly balanced layouts of the graphics and
texts on the page. There are three (3) types of balance o
in page design: z --:
lbalonce-
e Symmetrical - more or less the same amount of z
text/graphics on each half of the page
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* Asymmetrical - a small amount of visually heavy elements balanced by a large amount of visually
light elements.

¢ Radial - page elements more or less evenly distributed in a circular manner around a central point.

Proximity - arranging objects (text and/or images) into
groups closer together in order to convey meaning and

help disseminate their message. pfol' .tq

Alignment - aligning texts and graphics to create more
interesting, dynamic, or appropriate layouts.

Consistency and repetition - Consistency is often paired with repetition in good graphic design
principles.

® Using the same font (typeface, font size, and font color) for all
headlines throughout a newsletter.

¢ Placing all page numbers in the same location on the page fepet
throughout a publication.

® Using the same method of paragraph spacing (indent, space 4
below, etc.) for all paragraphs of text in an article. §‘°ali

Contrast - occurs when two parts of a design or page layout are
different. The greafer the difference, the greater the contrast. It's
one way of emphasizing parts of a layout or guiding the readers’
eye to specific areas of the page.

White space - is the absence of text and
graphics. White space provides visual space
for the eye.

Activity 2.0: Page 108-109




Publishing application
Desktop publishing software doesn't work in the same way as word processing software.
There are some basic similarities in how most desktop publishing page layout applications function. The tool names,

icons, and keyboard commands may differ, but most desktop publishing programs share some common
characteristics.

1. Pasteboard - Desktop publishing application use a pasteboard as a work area similar to a word document
window. You can move blocks of text and images off the page and leave them sitting on the pasteboard.
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2. Text Frames - Text frames hold text. Depending on the software, text frames may have handles for resizing or
dragging the text frames.
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